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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in August 2021

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Index Name Index Name
HS Mainland
HS Mainland
HS Mainland o
Properties Index _ ¥3.5%
HSI -0.3% I
FTSE A50 Index1.9%
HSCElI  -0.5% !
% Change % Change
Equity Index Futures Access Codes
HS Mainland HS Mainland
Vendor HS Mainland Banks Properties Oil & Gas CES 120 HSI HSCEI
Bloomberg BMWA PPTA OGIA CESA HIA HCA
Refinitiv 0#HMBI: O#HMPI: 0#HMOI: O#HCHH: 0#HSI: O#HCEL:
WIND MBIF MPIF MOIF CHHF HSIF HHIF
ET Net MBI MPI MOI CHH HSI HHI

Data Source: Bloomberg
As at 31 August 2021
Information for reference only
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Equity Index Futures & Options

Hang Seng Index (HSI) Futures & Options

HSI Products

(2021 vs 2020)

HSI Futures

Mini-HSI Futures

HSI Options

Mini-HSI Options
HSI Volatility

Index Futures

HSI Dividend
Point Index
Futures

Data Source: HKEX

142,110 (-15%)

103,300 (-8%)

27,989 (-29%)

11,831 (-12%)

0 (-100%)

45 (-55%)

* Ol compared to previous year-end
Information for reference onlv

As at 31 August 2021
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105,624 (-19%)

13,527 (-22%)

131,430 (-19%)

12,862 (+49%)

0()

3,781 (-2%)
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level

HSI & Top 5 Constituents

. Includes the largest and most ‘000
Index Description o i ) ('000)
liquid stocks listed in Hong Kong 30 - HSI HSI - 34 130 - HSI Index Tencent
Index Level 25,878.99 (As at 31 Aug 2021) 120 - HSBC —AlA
- 30 - CCB ~— China Mobile
Index Volatility (30-Day Historical) |22.1 28 110 4
. - 26 100 -
Index Avg. Day High-Low Range 409.51 (Aug 2021)
e 90 - ’
HSCE! Correlation (2021) 0.966 26 - =
80
- 18 70 -
Hang Seng Index Futures 24 . . 14 60
Jun-21  Jul-21 Aug-21 Jun-21 Jul-21 Aug-21
Contract Multiplier HK$50
Notional Value (1 Contract) HK$1.29Mn (As at 31 Aug 2021) Distribution of HSI Index Options Ol in Month-end
Call Put
Transaction Cost* 36.8
. 36.8 S 348
Stamp Duty NA 8 34.8 S38
c 328 ©308
.  30.
Trading Fee HK$10 / contract 3 ggg X 28.8
€ %6 © 26.8
SFC Levy HK$0.54 / contract L 48 % 24.8
h 228 — % 22.8
Commission Rate Negotiable % 20.8 g 20.8
E 19.4 =194 —
Margin as of 29 Jul 2021 HK$93,400 18.4 18.4 +—
14.0 T 14.0 T r )
0 2 4 0 2 4 6

Data Source: HKEX, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv
As at 31 August 2021
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Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Products AD\ HSCEI Futures (YoY) HSCEI Options (YoY)

(2021 VS 2020) Average Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
160,000 - == ADV (L-Axis) r 600,000 120,000 - ADV (L-Axis) r 2,800,000
Open Interest (R-Axig) Open Interest (R-Axis)
L i - 2,400,000
HSCEI Futures 125,205 (-14%) 356,975 (+23%) 100,000 . 500,000 100,000
- 400,000 80,000 - - 2,000,000
- 1,600,000
80,000 T - 300,000 60,000 -
e - 1,200,000
Mini HSCEI F 1
14,407 (-21%) 4,670 (+11%) 40,000 1 200000 40,000 - 800,000
Futures - 100,000 20,000 - 400,000
0 - 0 0 LI B B B B B B B B B R | 0
&) O N O O A0 X
. S PSS S S
HSCEI Options 45,900 (-45%) 1,629,387 (+8%) v
HSCEI Futures (MoM) HSCEI Options (MoM)

R Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
Mini HSCEI 1.500 (_34%) 6.292 (+80%) (No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
Options 220,000 - s ADV (L-Axis) - 600,000 150,000 - ADV (L-Axis) - 4,000,000

. Open Interest (R-Axis) - 500,000 Open Interest (R-Axis)
HSCEI Dividend 165,000 - - 3,000,000

A [ 400,000 100,000 -

Point Index 1,485 (-18%) 99,530 (+89%) | I
Futures 110,000 I I 1l - 300,000 - 2,000,000
- 200,000 50,000 -

55,000 - I
- 100,000 1,000,000
0 ° 0 > O > 0
= 33) caOss>cS O
8888885885332
2020 2021

Data Source: HKEX

* Ol compared to previous year-end
Information for reference onlv

As at 31 August 2021
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI HSCEI & Top 5 Constituents

Comprises the largest and
Index Description p,' . ¢
most liquid H shares 104 4 120 -
====HS| ==HSCEI e HSCE Ping An
Index Level 9,183.76 (As at 31 Aug 2021) ——ICBC ——CCB
110 - BOC = China Life
Index Volatility (30-Day Historical) | 23.6 100 1
_ 100 -
Index Avg. Day High-Low Range 184.14 (Aug 2021) _a
96 - 90
Correlation with HSI, CES120 (2021)| 0.966,0.911
- . 80 4
Correlation with CSI300, FTSE A50 0.69,0.69 92 . . . .
e S O & » &
F o & 9
Q Q N Vv ) Jun-21 Jul-21 Aug-21

Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.46Mn (As at 31 Aug 2021) Call Put
18.0 18.0
16.0 L 5160
sl44 £ g1
Transaction Cost S 134 E o
. gas
Stam p Dut NA o114
S € 10.4 £ 18-;‘
Q = 9.
Trading Fee HK$3.5 / contract = 22 N g4
@ o S 7.4
< 1.4 - !
SFC Levy HK$0.54 / contract 8 62 £ 62 F
£ 45 45 [
Commission Rate Negotiable 2.0 | T S 2.0 " r r s
0 20 40 0 20 40 60 80
Margin as of 29 Jul 2021 HK$34,550 Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 August 2021
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Weekly HSI & HSCEI Options Performance

Contract Multiplier HK$50 v
olume
o . Akuna, Eclipse, I-Access, IMC, Maven,  (No. of Contracts)
Liquidity Providers .
Optiver 20,000 -

® Weekly HSI Options

. SCEI Options
Transaction Cost*

Stamp Duty N/A 10,000 -
Trading Fee HK$10 / contract
SFC Levy HK$0.54 / contract
. . 0 -
Commission Rate Negotiable 00 00 00 00 GO 00 CO 00 CO OO0 0O OO0 CO OO0 0O Q0 0O OO GO O 0O OO
NP IFTHN ST AdTNNONDDONIWO RO o
A NN NANNNMM
i Volume
Weekly HSCEI Options e ontracts) |
Contract Multiplier HK$50 12,000 - e\ eekly HS| & HSCEI Options Call
L . Akuna, Eclipse, I-Access, IMC, Mawen, Weekly HSI & HSCEI Options Put
Liquidity Providers .
Optiver
8,000 -
1 *
Transaction Cost 4,000 -
Stamp Duty N/A
Trading Fee HK$3.5 / contract 0 —_—
00000 HoPLPDDDDNONO0O0OPWVW0PORX
SFC Levy HK$0.54 / contract ANHBITHN SOOI NMONDOOMNMIWON O A
™ A A N AN NN ANNOOM
Commission Rate Negotiable

An investment tool to manage short term event risk

Data Source: HKEX
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 August 2021

X



Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2021 vs 2020) _— No. of Single Stock Derivatives

Stock Futures 10,931 (+138%) 38,922 (+69%) Single Stock Futures
Stock Options 683,779 (+30%) 11,601,420 (+30%) Single Stock Options i
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Av erage Daily Volume Open Interest ~ Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
12,000 7 e ADV (L-Axis) r 45,000 800,000 - ADV (L-Axis) - 14,000,000 ST /A= IIITE
10,000 - Open Interest (R-Axis) ggggg Open Interest (R-Axis) _ - 12,000,000
8,000 30000 2000007 - 10,000000 - Products
- 25,000 ] -~ 8,000,000 » 3 A-shares ETFs futures contracts
6,000 400,000
- 20,000 - 6,000,000 > Total 91 stock futures contracts
4,000 I 18’888 200,000 ~ 4,000,000
2,000 - 5,000 ~ 2,000,000
O L 0 0 T T T T T T T T T T T T O
O N 0 o A Lo R
L° N AN N N\ N N
B PR PP
Stock Futures (MoM) Stock Options (MoM) Stock Options
Av erage Daily Volume Open Interest Average Daily Volume Open Interest * Products .
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts) » 3 A-shares ETFs options contracts
_ mmmmm ADV (L-AXis) ~ 1,000,000 - ADV (L-Axis) - 16,000,000 :
16,000 open ntereat (R-axis) [ 45000 Open Interest (R-AXis) > Total 117 stock options contracts
14,000 - S 40000 o oo
12000 1 2000 600000 A 12000000 . Market Makers (MMs)
8,000 - - 25,000 ’ - 8,000,000 > 3 types of market makers (PMM/ CQMM/
] - 20,000 400,000 - QRMM)
6,000 - 15,000 . . .
4,000 - - 10000 200000 - - 4,000,000 > CQMM to provide 50 series continuous
2,000 - - 5,000 ’ quotations
01 0 0 > O > 0
an >0 S = >N [oRh 31 c 55 c = g
5628882285533 §SSZRTERE332
2020 2021 2020 | 2021

Data Source: HKEX

* Ol compared to previous year-end
Information for reference onlv

As at 31 August 2021
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Hang Seng TECH Index Futures and Options Performance

Hang Seng TECH Index Open Interest (as of 31 August 2021)

Tracks the largest technology companies
Index Description _ _
listed in Hong Kong Open Interest
(No. of Contracts)
30,000 -
Hang Seng TECH Index Futures & Options 25,000 -
Contract Multiplier HK$50 per index point 20.000 -
Notional Value (1 Contract) HK$405K (As at 31 August 2021) 15.000 -
No. of Liquidity Providers Futures: 4; Options: 6 10.000 -
5,000 -
Transaction Cost* 0 -
Stam p Duty N/A
Trading Fee HK$5.00 / contract
SFC Levy HK$0.54 / contract 2020 | 2021 |
Average Daily Volume (as of August 2021)
ADV
(No. of Contracts)
28,000 -
24,000 -
20,000 -
16,000 -
12,000 -
8,000 -
4,000 -
0 -

2020 2021

Providing investors with a tool to manage their risk exposure

; . Volume and Open Interest are Incubating
to Hong Kong-listed technology companies

Data Source: HKEX

* Exclude commission fees

Information for reference onlv

As at 31 August 2021

X
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MSCI Asia and Emerging Market Index Futures Performance

MSCI Asia and Emerging Market Index Open Interest (As of 31 August 2021)

representation 38 DM and EM countries and

Index Description ; o Open Interest
regional indices (No. of Contracts)
100,000 -
MSCI Asia and Emerging Market Index Futures 80,000 -
Contract Multiplier Average US$40 60,000 -
Notional Value (1 Contract) Average US$52K (As at 31 August 2021)
No. of Liquidity Providers 14 40,000 1
20,000 -
Transaction Cost* 0
Stamp Duty N/A )
Trading Fee US$0.6-US$1.0 / contract | |
SFC Levy US$0.07 / contract 2020 2021
Average Daily Volume (As of August 2021)
ADV
(No. of Contracts)
10,000 -
8,000
6,000
4,000
2,000

0

2020 2021

HKEX with the broadest suite of MSCI derivatives products

. . . Volume and Open Interest continue to growth
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 31 August 2021
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MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

i Daseistian representation 2_ DM cour_1tries (excl. Japan) Open Interest
and 9 EM countries in Asia (No. of Contracts)
2,000 -
Index Level 641.18 (As at 31 August 2021)
Index Volatility (30-Day Historical) | 17.3 1,500
Index Avg. Day High-Low Range 6.80 (August 2021) 1,000
HSI Correlation (2021) 0.898 500
HSCEI Correlation (2021) 0.888 0
MSCI AxJ Futures
Contract Multiplier US$100
Notional Value (1 Contract) US$64K (As at 31 August 2021)
Avg. Quote Size US$0.32Mn (5 Contracts) MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)
Avg. Bid-Ask Trading Spread 1.0 index points (August 2021) 120 - mgg: g‘é] """""""" mgg: ICT:Ii'na mgg: :-"éo _
................ ndia ndonesia

S ST R . =~ | MSCI Korea - MSCI Malaysia MSCI Pakistan
Liguidity Providers Flow and 11 banks 110 4 MSCI Philippines MSCI Taiwan MSCI Thailand
Transaction Cost* 100
Stamp Duty N/A 90
Trading Fee US$0.5 / contract 80 -
SFC Levy US$0.07 / contract

70 T T 1

MSCI AxJ is a well-established benchmark representing Asia

Futures contracts have relatively lower transaction costs : . :
regional (excluding Japan) equity market performance

Data Source: HKEX

* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 31 August 2021
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Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI)

10 largest and most representative

Index Description _ )
HKEX-listed mainland banks stocks

Index Level 2,772.85 (As at 31 August 2021)

Index Volatility (30-Day Historical) | 23.6
Index Avg. Day High-Low Range 27.83 (August 2021)
HSI Correlation (2021) 0.563

HSCEI Correlation (2021) 0.546

Hang Seng Mainland Banks Index Futures
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.14Mn (As at 31 August 2021)

Avg. Quote Size HK$0.69Mn (5 Contracts)
Avg. Bid-Ask Trading Spread 65.2 index points (August 2021)

Liquidity Providers N/A

Transaction Cost*

Stam p Duty N/A
Trading Fee HK$2 / contract
SFC Levy HK$0.54 / contract

Margin as of 29 Jul 2021 HK$7,310

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 August 2021

X

5-Min Avg. Bid-Ask Spreads (31 August 2021)

HSMBI Futures 1.98%
CEB Bank 6818.HK
ABC 1288.HK

CITIC Bank 998.HK

CM Bank 3968.HK

Bank of China 3988.HK
Minsheng Bank 1988.HK
Bankcomm 3328.HK
ICBC 1398.HK

PSBC 1658.HK

CCB 939.HK

Index & Constituents 3-Month Performance (Rebased to 100)

110 - ——HSMBI ——CCB (939.HK)
ICBC (1398.HK) BOC (3988.HK)
105 - —— ABC (1288.HK)
100
95
90
85
80 . . .
Jun-2021 Jul-2021 Aug-2021

HSMBI Futures can be used for hedging

13



Hang Seng Mainland Oil & Gas Index Futures Performance

5-Min Avg. Bid-Ask Spreads (31 August 2021)

Hang Seng Mainland Oil & Gas Index (HSMOGI)

7 largest and most representative

Index Description
P HKEX-listed mainland oil & gas stocks HSMOGI Futures

2.47%
Index Level 1,182.64 (As at 31 August 2021)

Kunlun Energy 135.HK
Index Volatility (30-Day Historical) | 37.8

) Sinopec Corp 386.HK
Index Avg. Day High-Low Range 16.39 (August 2021)

HSI Correlation (2021) 0.536 PetroChina 857.HK
HSCE! Correlation (2021) 0.502 China Oilfield 2883 HK
Contract Multiplier HK$50
Notional Value (1 Contract) HK$59K (As at 31 August 2021)
Avg. Quote Size HK$0.30Mn (5 Contracts) Index & Constituents 3-Month Performance (Rebased to 100)
Avg. Bid-Ask Trading Spread 0.0 index points (August 2021) 140 - emm——HSMOGI —— PetroChina (857.HK)
Liquidity Providers N/A 130 - —— CNOOC (883.HK) Sinopec Corp (386.HK)
Kunlun Energy (135.HK)
120 - N\,‘/\
Stamp Duty N/A 100 "o~
Trading Fee HK$2 / contract 90 -
SFC Levy HK$0.54 / contract 80 7
Margin as of 29 Jul 2021 HK$4,020 A Jul-2021 Aug-2021 '
Futures contracts have relatively lower transaction costs HSMOGI Futures can be used for hedging

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 August 2021
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Hang Seng Mainland Properties Index Futures Performance

Hang Seng Mainland Properties Index (HSMPI) 5-Min Avg. Bid-Ask Spreads (31 August 2021)

10 largest and most representative

Index Description Fullshare 607.HK

HKEX-listed mainland properties stocks 1.11%
China Res Land 1109.HK

Index Level 4,996.95 (As at 31 August 2021)
Longfor PPT 960.HK
Index Volatility (30-Day Historical) | 31.7 China Overseas 688.HK
Index Avg. Day High-Low Range | 110.43 (August 2021) Kerry Ppt683.HK
Shimao Property 813.HK
HSI Correlation (2021) 0.601

Sino-Ocean Gp 3377.HK
HSCEIl Correlation (2021) 0.636 Evergrande 3333.HK
China Vanke 2202.HK

. . Country Garden 2007.HK
Hang Seng Mainland Properties Index Futures
HSMPI Futures

Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.25Mn (As at 31 August 2021)
Avg. Quote Size HK$1.2Mn (5 Contracts) Index & Constituents 3-Month Performance (Rebased to 100)
Avg. Bid-Ask Trading Spread 86.2 index points (August 2021) 125 - ==HSMPI Evergrande (3333.HK)
China Overseas (688.HK) Country Garden (2007.HK)
Liquidity Providers NA 110 - China Res Land (1109.HK)
95
Transaction Cost*
80
Stamp Duty N/A
Trading Fee HK$2 / contract 65
SFC Levy HK$0.54 / contract 50
Margin as of 29 Jul 2021 HK$18,220 35 ' ' '
Jun-2021 Jul-2021 Aug-2021
Futures contracts have relatively lower transaction costs HSMPI Futures can be used for hedging

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 August 2021
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CES120 Index Futures Performance

CES120 Index

80 A-Shares and 40 HK-listed Mainland

Index Description ) ) )
China H-shares, P-chips, and red chips

Index Level 7,065.55 (As at 31 August 2021)
Index Volatility (30-Day Historical) | 20.5

Index Avg. Day High-Low Range 130.85 (August 2021)

CSI300 Correlation (2021) 0.892

FTSE A50 Correlation (2021) 0.904

5-Min Avg. Bid-Ask Spreads (31 August 2021)

XiShares A50 ETF (2823.HK) - 0.20%

CSOP FTSE AS0 ETF (2822.HK) I 0.08%

i 0,
R 0 et S ChinaAMC CSI300 ETF(3188.HK)F 0.07%

Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.35Mn (As at 31 August 2021)
Average Quote Size HK$1.77Mn (5 Contracts)

Average Bid-Ask Trading Spread| 83.8 index points (August 2021)

Liquidity Providers N/A

115 Je——=CES120 Index

105 -

CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

Tencent CCB
Ping An ——— China Mobile

Transaction Cost* 95 1 \\/‘\\

Stamp Duty N/A

Trading Fee HK$5 / contract
SFC Levy HK$0.54 / contract
Margin as of 29 Jul 2021 HK$20,660

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 August 2021

X

85 -

75

65 T :
Jun-2021 Jul-2021 Aug-2021

CES120 Futures can be used to hedge A-share positions
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Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information ~ HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI China ia [MSCI EM Asia MSCI EM MSCIEM ex |MSCIEMex |MSCIEM
. Free NTR i ex Korea NTR [MSCI EM Asia [EMEA NTR China NTR Korea NTR LatAm NTR
Information [NTR (USD) Free (USD) (USD) Index (USD) Index  [NTR (USD) (USD) Index  |[(USD) Index |(USD) Index |(USD) Index
Vendor Index Futures |Index Futures |[Futures Futures Index Futures |Futures Futures Futures Futures
Bloomberg HKCA Index HMSA Index  HJEA Index HQOA Index HQRA Index HRSA Index HQTA Index HQDA Index  HQIA Index HQYA Index
Refinitiv 0#HMAN: 0#HMCU: 0#HMCN: 0#HMAC: 0#HMAK: O#HEAN: 0#HMEE: 0#HMXC: 0#HMXK: O0#HMEL:
WIND MANF.HK MCNF.HK EANF.HK

MSCI Hong MSCI MSCI
. Kong NTR MSCI India MSCI India Indonesia Indonesia NTR|MSCI Japan  |MSCl Japan [MSCI Japan
Information (USD) Index  |(USD) Index |NTR (USD) Index (USD) |(USD) Index [(JPY) Index NTR (JPY) NTR (USD)
Vendor Futures Futures Index Futures |Futures Futures Futures Index Futures |Index Futures
Bloomberg HMPA Index  HMOA Index  HLCA Index HRTA Index HJDA Index HMLA Index HKBA Index HQAA Index  HQBA Index  HJCA Index
Refinitiv O#HMEM: O#HEMN: O#HMHN: O#HMDA: O#HMIN: 0#HMID: 0#HMDN: O#HMJP: O#HMJJ: 0#HMJU:
WIND MINF.HK MDNF.HK MJUF.HK

MSCI
MSCI New MSCI Pacific MSCI MSCI Singapore MSCI
: MSCI Malaysia [MSCI Malaysia |Zealand NTR [ex Japan NTR |[MSCI Pacific |Philippines ilippi Singapore Free NTR Singapore

Information [USD) Index |NTR (USD) (USD) Index  |(USD) Index |NTR (USD) (USD) Index Free (SGD) (USD) Index  |NTR (USD)

Vendor Futures Index Futures |Futures Futures Index Futures |Futures Index Futures |Index Futures |Futures Index Futures
Bloomberg HMYA Index HKEA Index HOPA Index HRPA Index HRBA Index  HNSA Index HLEA Index HKOA Index HOBA Index HKPA Index
Refinitiv 0#HMMY: 0#HMMN: 0#HMNZ: 0#HMPJ: 0#HMPC: 0#HMPH: 0#HMPN: 0#HMSG: 0#HMGN: O#HMSN:
WIND MMNF.HK

MSCI Taiwan
: MSCI Taiwan [MSCI Taiwan |25/50 NTR MSCI Taiwan [MSCI Thailand |MSCI Thailand [MSCI Vietnam [MSCI Vietnam
Information [USD) Index  [25/50 (USD)  |(USD) Index  |NTR (USD) (USD) Index  [NTR (USD) (USD) Index  [NTR (USD)
Vendor Futures Index Futures |Futures Index Futures |Futures Index Futures |Futures Index Futures
Bloomberg HJAA Index HRCA Index HRDA Index HJBA Index HMTA Index HKDA Index HNTA Index HKSA Index
Refinitiv O#HMTW: O#HTWP: O#HTWN: O#HMWN: O#HMTH: O#HMTN: O#HMVT: O#HMVN:
WIND MTWFE.HK MWNF.HK MTNF.HK

Data Source: HKEX

X ’



Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Mainland Banks
Index

Information Vendor

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Mainland Banks
Index

Information Vendor

East Money HSMBI
Hexin Flush Financial

Pobo Financial

Qianlong 999905
Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
O0#HMBI:

Mainland Banks
Index Futures

MBI
MBIC
MBI+Month+Ye
ar

209

MBIF+yymm-+H
K

Mainland Mainland
Properties Properties Index
Index Futures
221425
=0200800.HK MPI/16K.HF
837451 870810
MSMPI Index PPTA Index
MPI
MPR MPI
MSMPI MPI
SEHK.HHSMPI P11224
MPImy
.HSMPI O#HMPI:
Mainland Mainland
Properties Index | Properties Index
Futures
HSMPI MPI
MPIC

MPI+Month+Year
999902 209

HSMPI MPIF+yymm-+HK

Mainland Oil
& Gas Index

=0201000.HK
837451
HSMOGI Index

MOG

MOGI

SEHK.HHSMO
Gl

.HSMOGI

Mainland Oil
& Gas Index

HSMOGI

999903

HSMOGI

Mainland Oil &
Gas Index
Futures

221415
MOI/16K.HF
870808
OGIA Index

MOl
MOl
MOl

P11222

MOImy
0#HMOI:

Mainland QOil &

Gas Index

Futures

MOI
MOIC
MOI+Month+Ye
ar

209

MOIF+yymm+H
K
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. i CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X



